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Free bass booster apps for pc

Here is a list of the best free bass enhancement software for Windows. These programs are used to increase bass levels of sound. Bass is actually a low-frequency sound ranging from 20 to 200 Hz. Many of the programs included in this list are media players that use tie to enhance bass. The equalizer used by these modes players have
different frequency ranges, but can increase a few frequency bands and bass levels. The common frequency bands in which these bass programs are produced are 60 Hz, 31.25 Hz and 62 Hz. Through these media players, you can get a boost of about 15 to 20 decibels. Apart from frequency ranges, you can also use presets such as full
bass, bass, triple, etc., to enhance bass levels. A few of the programs listed here work at the system level. This means that you can use any media player to play any audio or video file, and you will still get enhanced bass levels. These system level programs fail down as they do not provide their media players. Some audio editing
software that can enhance sound is also included in this list. The main advantage of audio editing software is that you can increase bass levels from some selected portion of the audio. In addition, they also let you save audio in different audio formats. Almost all of these bass enhancement programs support many popular audio formats
such as MP3, AAC, WMA, MP2, OGG, M4A, etc. My favorite Bass Booster Windows software is: ViPER4Windows is my favorite audio booster because it runs at the system level and provides a maximum bass increase of up to 18.06 dB. No matter which media player you use to play audio or video, you still get enhanced bass levels. The
18-band frequency tie is also handy as you can vary various other audio parameters such as triple, etc. You can also check out the best free audio booster lists, music making, and audio pitch-overper software for Windows. ViPER4Windows ViPER4Windows is a free audio driver and bass booster for Windows. It comes with different
sound effects such as gain control, tie, VIPER XBass, surround 3D, compressor, etc. You can easily change the various sound parameters of its interface. After customizing audio parameters, use any media player to play audio/video. You can immediately hear the enhancement in the output sound. This program provides three audio
modes named Music Mode, Movie Mode, Free. All three audio modes have the ViPER XBass section, from which you can increase the bass to 18.06 dB. However, free mode contains two more additional options to enhance any bass, natural bass and pure bass. Enhanced bass produced by natural bass option does not overwhelm the
sound of other instruments. However, pure bass option focuses purely on bass levels. As a result, the voice of other instruments is suppressed. A full 18 frequency tie range is also available in it. Using the equalizer, you can easily change every available frequency between -120 dB to 13 dB. This tie can also be used to change bass, and
triple, And various other audio parameters. This software also has some advanced audio options such as Echo, Convolver, Viber XClarity, Technology Treatment, and ViPER Smart Size. The advanced options available provide a lot of sound control and also help adjust the sound. FxSound FxSound is a free bass enhancement software
for Windows. It is used to enhance the overall bass and sound of the system. It takes on the default audio drivers from the computer to enhance the sound. The audio does not play per se, so you must play the media player to play audio files. This free audio booster offers two options primarily for voice enhancement, Dynamic Boost and
Bass. You can view these options in the Effects menu. The dynamic reinforcement option is used to enhance overall sound with bass. However, the Bass option only enhances bass levels without changing any other audio parameter value. The effects list contains more audio options: Fidelity, Atmosphere, and 3Dsurround. In this free
version of FxSound, you can enhance bass and other audio parameters up to a level of 5 or 50 percent. In addition, its 3D peripheral option is completely disabled. You need to buy its full version to enjoy all the features without restrictions. This audio booster also provides 9 frequency tie band to manually uneven different parameters
(bass, triple, etc.) of sound. Getting the desired sound levels using the equalizer is still a little tricky, it is a good choice to have. Note: This free version of FxSound has different limitations. You need to buy its full version to remove all restrictions. Audacity Audacity is a free and open source windows audio editor program. It provides a lot of
audio editing tools and effects to enhance sound. Bass is also a sound effect and you can vary bass levels through this program. Along with bass, various other sound effects such as triple, tempo, echo, pitch, etc., can also be varied. Moreover, you can record the sound and play it directly in audacity too. To enhance sound, first, go to
effects &gt; bass and triple. The bass option has three three sliders through which you can increase or decrease bass, triple, and audio levels between -30 to 30. After adjustments to sound levels, apply changes and preview the sound using its audio player. Here, you can also save the edits on it in advance for later use. The main
advantage of the audio editor program on other bass enhancement programs is that in the audio editor, you can apply effects to a selected portion of the audio. To select a specific part of the sound, just click and drag the mouse over the time line of the sound. Now, you can easily enhance bass or apply any other effect to the selected
audio part. In audacity, you need to export sound in order to save bass enhanced sound in audio formats such as .mp3, .ogg, .flac, .mp2, etc. However, the export option needs a lame .dll enc file in order to export audio in a different audio format. Clicking on the audio export option opens a small window, through which you can download
or browse the lame encryption file. In the square It is a great sound editor that can provide a great deal of boost in bass levels of sound. Windows Media Player Windows Media Player is a popular media player program that comes by default with Windows. Audio and video can be played from various formats such as WMV, WMA, ASF,
AAC, AVI, and more. In case you don't know, it is also able to enhance bass levels from both audio and video files. How to enhance bass in Windows Media Player: To enhance bass, first, right-click on its interface and go to improvements &gt; wow SRS effects settings. In this setting, you can view two options: Tropas and WOW effect.
Tropas is a custom option to enhance bass levels up to 100 level. You can notice the increase in bass levels immediately after the bass values increase. However, the WOW effect provides an overall increase in bass sound and tool background that looks more accurate than the input audio. It also provides 10 frequency tie range for
contrast various aspects of sound such as bass, triple, vocals, pitch, etc. Frequency tie can be useful if you know any frequency range affects any part of the sound. Moo0 Audio Effecter Moo0 Audio Effector is the latest free bass enhancement software for Windows. It is a direct program with an uncomplicated interface. Along with bass, it
is also able to enhance the pitch, size, and even vocals of an audio file. The only aspect I don't like about it is that it only supports MP3 and WAV formats. In this bass booster, you can select the bass enhancement option from converting to drop-down menu. The bass enhancement option lets you enhance bass up to level 10. You can
also change the output file folder before enhancing the sound. After setup, you can drag and drop an audio file directly on its interface to get a bass audio file enhancement and output. Converting to drop down menu contains two more bass-related options named Bass Only and Bass Funnel. Bass is the only interesting option rather than
a bass enhancement, it actually suppresses other parameters of sound except bass levels. Bass funnel option simply prevents bass levels up to level 10. This program is especially for those people who need to promote simple bass and free software. VLC Media Player VLC Media Player is an open source media player software free of
charge for Windows. It is also a popular media player that can play both audio and video files of various formats such as MP4, AVI, WMV, MP3, AAC, etc. Along with media files, you can also add various audio and video to the video/files that you are currently playing. In its effects and filter list, you can view 10 tie range through which you
can enhance bass levels of audio and video files. How to enhance bass in VLC Media Player: Open the tie directly from its interface by clicking on the tie icon or accessing it from tools &gt; effects and filters. Now, enable the equalizer by ticking the enabled and 2 pass option. Move the 60 Hz slider in the upward direction to enhance the
bass. Maximum bass increase up to 19.9 dB Can be achieved by this option. You can use the remaining other sliders to enhance various other audio parameters such as triple, pitch, etc. In the tie, you can also get some presets like jazz, pop, full bass, etc. From the available presets, full bass and full bass and triple also provide a large
amount of bass enhancement. SM Player SM Player is an open source media player program free of charge for Windows that claims to play almost all audio and video formats. It has various built-in codecs that help this player to play a variety of audio and video formats. Here, you can also find many advanced options such as audio filter,
video filter, change playspeed, video equalizer, etc. This media player also uses a tie like many other media players to enhance bass levels. You can reach the draw by going to the sound drop-down menu. The equalizer that you find here consists of 10 frequency bands with a pre-defined list. The pre-menu contains two bass-related
options named Full Bass and Full Bass and Triple. Full bass only enhances bass levels, while full bass and triple increases both bass levels and triple sound. If you want to increase bass levels manually, then you need to move 31.25 and 62.50 Hz sliders in the upward direction. The bass enhancement you get through this program is very
large and you can immediately feel the increase in bass levels. Clementine Music Player Clementine Music player is a free music player software for Windows with the ability to enhance sound. It is a dedicated music player with lots of features that focus solely on music. Some useful features of Clementine are Internet Radio, discover and
download podcasts, search and play songs from Dropbox, Google Drive etc. Clementine explorer provides his own file explorer to search and add audio files. All added files can be displayed on its interface. It also has a tie through which you can enhance bass levels from any audio file. From the tools menu, you can access the equalizer.
The forward edited equivalent contains 10 frequency ranges, including a pre-defined list. From the preset menu, you can select a full bass or bass + triple option. In full bass, you get a big boost in bass levels, but the sounds of other instruments get suppressed. Bass + Treble enhances bass and triple levels to provide a more balanced
output sound. To manually increase bass levels, you need to increase the value of the 60 Hz frequency band. Various frequency settings can be manually saved as pre-set and can be used later. From this equalizer, you can also increase sound levels by increasing the slider before the amp. This bass booster supports various audio
formats such as MP3, OGG, FLAC, M4A, AAC, etc. In addition, you can also import playlists directly in M3U, M3U8, XSPF, PLS, ASX and CUE formats. GOM Player GOM is a completely free media player software for Windows. It can also be used as bass booster software. To boost bass levels using GOM player, first, you have to
access the control panel either by pressing the F7 or On the control panel button. The control panel has four options named video, audio, subtitle, and control. Select the audio option that has 10 frequency equalizer range. Click and drag the 60 Hz frequency slider in the direction to the top in order to enhance the bass. Bass levels up to
12 decibels can be achieved by this tie. If you want to change other sound parameters, then use the remaining 9 frequency sliders. In this bass booster, you can also find different advanced options such as 360 degree video player, VR video support, GOM remote to control this player, subtitle finder, etc. It also supports a lot of media
formats such as MP4, FLV, MOV, MPG, MP3, AAC, OGG, FLAC, WAV, etc. All these formats are supported including different manual options make it a good media player as well as a bass booster. Each player is another free media player that can also enhance the bass of sound. In this media player, you can play and enhance bass
levels for both audio and video files. Explorer provides files to search and add media files to. You can also drag and drop audio/video files to its interface to play them. It supports many audio and video formats, so you don't need to use different programs to play audio/video files from different formats. This bass equalizer booster is used as
well as some presets to enhance bass levels. The tie can be reached by clicking on the tie settings icon that is located in the lower right corner of the interface. In the tie settings, there are 10 tie range along with different presets. However, the available frequency bands do not have any markings on them, to determine the frequency that
represents each of the available bands. Still during the test, I noticed that the first two frequency bands from the left provide a large amount of boost. Tie can also be used to vary sound parameters such as triple fold, balance, loud sound, etc. This program has many presets such as flat, classic, club, dance, full bass, bass and triple, etc.
From the various presets available, full bass and 'bass and three' presets provide a good amount of boost. The only difference between these two presets is that one of them only enhances bass, while the other one enhances both bass and three levels. As a media player, it is a very advanced one because it supports 4K video playback,
online streaming video, online radio, advanced coding, etc. BitTorrent Video Player Torrent Video Player Player Is a free media player software for Windows. It is a VLC Player-based media player that can turn on any bittorrent file while downloading it. Modeled on VLC player, it can also be used to enhance bass levels. Along with bass,
its sound enhancement capability is also really good as you can increase the volume by 200%. This bass booster program also uses an internal equalizer in order to enhance bass. To access the equalizer, go to Tools &gt; Effects &gt; Sound Effects &gt; Equalizer. In the equalizer, you can view 10 frequency range, preamp slider, preset
menu, two named enabled selection squares and 2 passes. Mark both check boxes and increase the frequency band of 60 Hz. You can instantly feel the increase in bass levels of sound. Presets, especially a full one bass, also provides a slight boost in bass. Using this program, you can also add dynamic range, wet, dry, humid, etc., and
sound effects to sound. Its main advantage is that you can play and enhance bass from various audio and video formats. POT PLAYER POT is a completely free windows player/video program. As a media player, it can easily handle a variety of audio and video formats. You can also use it to enhance bass and audio levels of audio and
video files. Let's see how to enhance bass using POT Player: In this player, you can access the control panel from the main interface. The control panel contains different menus called audio, video, subtitle, and playback. In the audio menu you can view the band frequency tie 10 to enhance bass. But before changing the tie frequency,
first, enable the tie by clicking on the tie check box. Next, move the 60Hz frequency slider up to enhance the bass. There is another option to promote bass named pre-list. From the pre-list, select full bass or bass and triple-preset to enhance only bass or both bass and triple levels, respectively. In this media player, you can also find some
advanced features such as 360 degree player, 3D player, translation support, webcast, etc. The POT interface is unique because of its modular design that lets you open different settings simultaneously in different windows or modules. Spyder Player Player is a simple and stylish bass enhancement software for Windows. It is used to
play audio files from many formats such as MP3, AAC, WMA, MP2, OGG, AIF, AIFF, and more. The resulting sound produced by these programs is very impressive. This program provides a modular interface, and most settings and functions open in different modules. At any time, you can enable or disable any module as needed. The tie
unit is one that needs to enhance bass. Just click the EQ button to open the tie unit. In the equalizer, you can get 10 frequency bands, but only 31 HZ and 62 Hz can enhance bass values. With the remaining frequency bands, you can change other sound parameters. The pre-set list of equations is also present in the equalizer unit. From
the various presets available, you can choose a full preset bass that can give you a slight boost in bass levels. Spider Player also offers some useful features such as file adapter, audio recorder, Hotkeys, playlists, etc. Overall, this bass booster is good at enhancing bass as well as in running audio files. Passion Audio Player Passion
Audio Player is another Windows media player program. It provides various useful features such as excellent operating quality, tie-ups, playlist editor, zip file support, etc. Its main advantage is that it uses bass API 2.4 to provide excellent levels of bass. Bass quality is also really good. It's also. Bass API to play media of various formats,
such as OGG, MP3, MP2, WAV, FLAC, etc. This bass booster program has a modular interface and at any time, you can enable or disable available modules except for the main interface. The main interface has an EQ button, press it and open its tie. The equalizer you get here has 10 frequency bands, two sliders change the tempo, one
before amplifying the slider to enhance the sound. Using 31 Hz and 62 Hz sliders, you can achieve a large amount of boost. Some other audio parameters such as pitch, balance, size, tempo, etc., can vary while playing audio or video file. Its visual modules and playlist are also useful as the visual unit displays the difference of frequency
in music playback while the playlist lets you add different audio and video files in the queue. Xion Audio Player Xion Audio Player is a dedicated audio player program, which can also enhance bass levels of sound. It is a carefully designed audio player with a beautiful user interface. This bass booster also uses a tie for bass enhancement.
Just below its main interface, there is a unit of 10 frequency. Increasing the value of 32 Hz and 64 Hz can provide a good amount of batch frequency slider in bass levels. Xion Audio Player also has a pre-list, but does not have a list that contains the main interface. To reach the menu beforehand, right-click on its main interface, select
composition, and open the internal tie. This internal tie is similar to the current tie on the main interface, except for one difference that has a pre-list. From the menu beforehand, select a full bass option to enhance the bass level. At the maximum, you can increase bass levels up to 15 decibels. This program also provides the option of xion
configuration, through which you can configure important settings such as visualization, hot keys, file types, output files, etc. MusicBee Player MusicBee is an advanced and open source music play software Windows. It has many advanced features, one of which is an automatic scan feature that automatically scans your computer to find
music files. The sync feature is also very good, and if you have a MusicBee account then you can keep similar playlists in different devices. MusicBee can also be used as a bass booster as it has common bass enhancement features such as equalizer and preset settings. Unlike other media or video players, this program provides a
complete draw that has 15 frequency bands. But of the 15 bands, there are only two useful frequencies, 32 Hz and 64 Hz. Increase the value of 32 and 64 Hz frequency ranges to get enhanced bass levels. The pre-menu has a full bass feature that will help you get a good amount of bass enhancement. Overall the sound quality and bass
boost offered by this program is very impressive. In this program, you can also view different sections such as playlist, play now, podcast, music player, music, All these music related features are also very useful for use. XMPlay XMPlay is a free and portable audio player for Windows. Using it, you can improve bass levels of sound, song,
etc. It has a basic 10 tie frequency band on the main interface, which can be used to enhance bass, triple, etc. In order to enhance bass, increase the value of 63 Hz bandwidth frequency. By parizing, you can achieve an increase in bass levels of up to 10 decibels. XMPlay can also be used to enhance sound as it has automatic
amplification in addition to manual amplification feature. Audio enhancement features can easily provide up to 20 decibels of audio enhancements. This mobile bass booster program can play audio or music of various formats, such as OGG, MP3, MP2, MP1, WMA, WAV, AIFF, and more. It also supports many playlist formats (PLS, M3U,



ASX, CUE) and ZIP archives as well. Cso Player BS. Player is another popular media player software with the ability to enhance bass. Bass can enhance both audio and video files. It supports a lot of audio and video formats. This bass booster has two features through which you can enhance bass named Equalizer and Presets. In the
tie, you need to increase the value of the frequency band of 60 Hz. At the maximum, this band can provide you with a bass level of up to 20 decibels. The pre-menu has various preset preset values, such as flat, full bass, bass and triple, pop, etc. By selecting full bass or bass and triple-preset, you can increase bass sound levels. Presets
basically change this type of audio or video playback by automatically adjusting the tie frequency. This program also offers some useful features: online radio (which lets you listen as well as download music through it), podcast (to listen to an audio version of various shows and discussions), etc. Online TV is also available, but it did not
work during testing. Test.
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